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Copyright Notice
Entire contents Copyright 1993, 1994, 1995 by Next Generation Software, Inc.    All rights 
reserved.    

The files american.vtd and vtspell.vbx are Copyright 1994 by Visual Tools, Inc. and 
distributed under a licensing agreement between Next Generation Software, Inc. and Visual
Tools, Inc.

The file vbmsg.vbh is Copyright 1993 by JOSWare, Inc. and distributed under a licensing 
agreement between Next Generation Software, Inc. and JOSWare, Inc.

Spell Check is provided for evaluation purposes only.    Please Register the Application or 
remove it from your system within thirty days.
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Spell Checking a Message
You must create a message in your frontend application (WinCIM, AOL, Notepad etc.) before
Spell Check can check your message.    After you finish typing your message execute the 
steps described below.

Remember, Spell Check must be running before you can check a message.    If Spell Check 
is running you must restore it before checking a message.        

To Start Spell Check:
1 Simply Double Click on the Spell Check Icon
      or 
      Press the user Defined Hot-Key (normally CTRL + ALT + S) while using the Program 
Manager.
2 If Spell Check Runs Minimized simply double click on the minimized icon.

To restore Spell Check after it is already running:
1    Press Spell Check's hot-key or
        Double Click on the Minimized Icon or
        Switch to Spell Check using the Windows Task List (CTRL + ESC).
        Click on the Spell Check Menu item.

To Begin Checking a Message:
1    If the Select Application Window is not visible press the Get Message Button, otherwise 
skip to Step 2.
2    Select the Application that contains the text you want to check by choosing the 
application's name from the drop-down list.    Under most circumstances Spell Check will 
anticipate what application contains the text.
3    Select a Closing.    Spell Check can automatically add a closing, such as your email 
address, to the message after the spell check is completed.    See Defining a Closing for 
more information on closings.
4    Select the desired Other Options.    Auto Update will cause Spell Check to automatically 
update the corrected text to the frontend application when the spell check is completed.    
Stay on Top will make the Spell Check icon remain visible after the spell check is 
completed.    See Summary of Default Settings.      
5.    Select the Type of Message (Mail or Forum) or press the Text button.
6.    Spell Check will grab the text and spell check it.    See Using the Misspelled Word Dialog 
Box.

Note:    To set the startup defaults press the Defaults button.

Related Topics:
Activating the Hot-Key Feature
Adding Spell Check to the Startup Group
Adding Spell Check's Icon to the Program Manager
Using the Spell Check 3.1 Setup Utility
Summary of Default Settings
Using the Misspelled Word Dialog Box



Other Features
Spell Check has several other features that enhance its functionality.

Cutting, Copying and Pasting Text.    To access these features simply highlight the 
desired text and choose the appropriate item from the Edit Menu.    It is possible to use 
these features to edit an existing message in Spell Check or exchange text with other 
applications in the Windows Environment.

Starting a Spell Check Manually.    To start a spell check manually simply select the 
Check Spelling item from the Edit Menu.    This feature is useful if you have previously 
cancelled a spell check and want to restart the spell checker.

Clearing the Current Message.    To clear the current message select the Clear Current 
Message item from the Edit Menu.

Updating the Current Message    To update the current message to a program press the 
update button.    Select the desired application.

Accessing On-Line Help.    To access the on-line help system simply select the Contents 
item from the Help Menu or for context sensitive help press F1.

Popping-Up the Edit Menu.    To activate the Edit Menu popup feature click the right 
mouse button while the pointer is over the current message box.

Related Topics:
Table of Contents



Editing the Custom Dictionary
When you Add words to the dictionary they are stored in the user defined custom dictionary
file (vtc extension).    To edit the custom dictionary simply open the file in your favorite text 
editor (Windows Notepad) and make the desired changes.    Save the File.    

To Determine the file name and path of your custom dictionaries:
1    Open the File c:\windows\Spell3.ini using the Windows Notepad.
2    Scroll to the End of the File.
3    The section labeled "[Custom Dictionaries]" will contain entries for the names and paths 
of the custom dictionary files.    
4    Make note of the filenames
5    Close spell3.ini
6    Open the custom dictionary file
7    Make the desired changes and save the file.
 
Related Topics:
Custom Dictionaries 



Technical Support
Next Generation Software, Inc. provides technical support for Spell Check users via 
electronic mail.    When seeking technical support be sure to clearly document the problem 
and if possible, attempt to recreate it.    Send requests for technical support to:
 
CompuServe - 72154,1174 
America Online - NEXTGENSFT.
Internet - nextgensft@aol.com

We pride ourselves on providing quick and accurate responses to our users.    If you have a 
question about the program or a suggestion about a new feature, we want to hear from 
you.      

Please note that Registered Users receive priority support.    Please include your invoice 
number in the Subject Box of your message to helps us recognize that you are a registered 
user.    

Checkout our Internet Homepage.    You will find the latest versions of our shareware 
programs, information on using Spell Check with popular Internet software and answers to 
frequently asked questions.    

Point your browser to http://www.xmisssion.com/~gastown/NEXTGENSFT/

Related Topics:
Registering Spell Check

Click here to learn more about Next Generation Software's 
Shareware Utility MailBag Plus 1.1



Using the Misspelled Word Dialog Box
The misspelled word dialog box will appear when Spell Check cannot find a word in its main
or custom dictionaries.

Simply select the word from the suggestion list and press the replace button.    Below you 
will find descriptions of the misspelled dialog box's buttons. 

Ignore Button.    Spell Check ignores the word and continues spell checking.

Ignore All Button.    Spell Check ignores the word as well as all subsequent occurrences 
and continues spell checking.

Replace Button.    Spell Check replaces the "Not in Dictionary" word with the "Replace 
with" word.    Select a word from the suggestions box or type a word directly in the Replace 
with box.

Replace All Button.    Spell Check executes the Replace function for the current word as 
well as for all subsequent occurrences of the "Not in Dictionary" word.

Add Button. Spell Check adds the "Not in Dictionary" word to the custom dictionary.    Spell
Check will treat all subsequent occurrences of the word as a correctly spelled.    Multiple 
custom dictionaries can be opened simultaneously.    The user can select the desired 
custom dictionary to add the word to from the "Add Word To" drop-down menu.    See 
Custom Dictionaries        

Suggestions.    Spell Check generates a list of suggested spellings for the currently 
misspelled word.    Also, Spell Check can generate suggestions for any word typed in the 
"Replace With" box.

Options Button.    Spell Check displays the Spell Options dialog box.    The user defined 
options are explained in the next section - Summary of Spell Engine Options.

Cancel Button.    Spell Check stops checking the current message.

If the Auto Update feature is enabled, Spell Check will update the corrected message to the
front-end application after the spell check is completed.    If the Auto Update feature is 
disabled you will be prompted as to whether to update the message to your front-end 
application.

Related Topics:
Spell Checking a Message
Summary of Spell Engine Options



Stay on Top After Spell Check
The Stay on Top After Spell Check setting makes the minimized Spell Check icon remain 
visible at all times (even when you are using another application).    Thus, making it 
possible to activate Spell Check by simply double clicking on the minimized icon.

Related Topics:
Setting Default Settings 
Summary of Default Settings
Running Spell Check Minimized



Running Spell Check Minimized
By selecting Run Spell Check Minimized, Spell Check will be minimized to an icon whenever
you start it.    Many users find it desirable to Add Spell Check to the Startup Group, Define a 
hot-key and Run Spell Check Minimized.

See Setting Defaults for instructions on defining Spell Check's defaults.

Note:    The Run Spell Check Minimized when Loaded setting overrides the Run Minimized 
Property in the Program Manager.

Related Topics
Adding Spell Check to the Startup Group
Adding the Spell Check Icon to the Program Manager 
Stay on Top After Spell Check



Adding Spell Check to the Startup Group
This topic is provided for information purposes only.    It is recommended that you see Using
the Spell Check 3.1 Setup Utility.

Any icons stored in the Startup Group load the corresponding programs each time Windows
is started.    You may find it desirable to add Spell Check to the Startup Group.

To add Spell Check to the Startup Group:
1    Switch to the Program Manager
2    Open the Startup Program Group
3    Select the New Item from the File Menu
4    Select Program Item and Press OK
5    Enter a Description "Spell Check 3.1"
6    Enter the Command Line.    The Command Line should contain the full path for Spell 
Check.    For example, c:\spell\wcspell3.exe.    If you downloaded Spell Check from America 
Online, Spell Check is likely stored in c:\waol\download\wcspell3\wcspell3.exe.    You may 
find it useful to press the browse button, navigate the directory tree and click on the file 
wcspell3.exe.
7    Leave the Working Directory Field Blank
8    Enter a Shortcut Key such as "S".    See Activating a Hot-Key for more information.
9    Press the OK Button.

Related Topics
Adding the Spell Check Icon to the Program Manager 
Running Spell Check Minimized
Using Spell Check with Norton Desktop



Adding the Spell Check Icon to the Program Manager
You may want to consider Adding Spell Check to the Startup Group.

Version 3.1 is distributed with the Spell Check 3.1 Setup Utility.    Simply double-click on the 
file spsetup.exe in the file manager and setup utility will create a full set of Spell Check 
icons.

To create an icon for Spell Check:
1    Switch to the Program Manager
2    Open the the Desired Group
3    Select the New Item from the File Menu
4    Select Program Item and Press OK
5    Enter a Description "Spell Check 3.0"
6    Enter the Command Line.    The Command Line should contain the full path for Spell 
Check.    For example, c:\spell\wcspell3.exe.    If you downloaded Spell Check from America 
Online, Spell Check is likely stored in c:\waol\download\wcspell3\wcspell3.exe.    You may 
find it useful to press the browse button, navigate the directory tree and click on the file 
wcspell3.exe.
7    Leave the Working Directory Field Blank
8    Enter a Shortcut Key such as "S".    See Activating a Hot-Key for more information.
9    Press the OK Button.

Related Topics
Adding Spell Check to the Startup Group
Running Spell Check Minimized
Using Spell Check with Norton Desktop



Activating the Hot-Key Feature
Whenever you restore Spell Check, the "get message" function is invoked.    If you are using
Windows 3.1 or Norton Desktop for Windows, you can assign a hot-key to Spell Check.    
Every time you press the hot-key, Spell Check will be activated.

Next Generation recommends using the hot key combination CTRL + ALT + S.    The 
procedures outlined below assume that you assign the recommended hot-key combination.

Before assigning a hot-key you must Add the Spell Check icon to the Program Manager.    
See Using the Spell Check 3.1 Setup Utility

To Activate the Hot-Key Feature:
1.    Select the Spell Check program icon in the Program Manager with a single-click.
2.    Select the Properties Item from the File Menu.
3.    Move to the Shortcut Key field.
4.    Press S.
          The field will change to "CTRL + ALT + S"
5.    Press OK.

Note:    Under Windows 3.1, you must have the Windows 3.1 Program Manager in the 
foreground the first time you press the hot-key combination.    In other words, Spell Check 
will not be activated if you press the hot-key combination for the first time while using 
another application, such as WinCIM.    The hot-key will call Spell Check while using another 
application (such as WinCIM) if Spell Check is already running.    Next Generation 
recommends adding Spell Check to your Startup Program Group as well as defining a hot-
key combiantion as discussed above.        

Related Topics
Adding Spell Check to the Startup Group
Adding the Spell Check Icon to the Program Manager 
Running Spell Check Minimized



Summary of Default Settings
This section provides brief descriptions of Spell Check's Default Options.    See Setting 
Defaults.      If additional explanation is warranted the summary for the option will contain a 
jump to a topic that provides further clarification.    The Default Settings are stored in the 
Spell3.INI file.    The line where the option is stored is denoted in Blue.    Default Settings 
are denoted in Red.

Run Spell Check Minimized.    Spell Check will run as a minimized icon whenever Spell 
Check is loaded.    Spell3.ini - RunMin= Default is No    See Running Spell Check 
Minimized for further explanation. 

Stay on Top After Spell Check.    The Spell Check icon will remain visible at all times ("on
top") thus, allowing you to simply double click on the icon to invoke the Spell Checker.    
Spell3.ini - StayOnTop= Default is no    See Stay on Top.

Automatically Update When Spell Check Complete.    Activating this setting will cause 
Spell Check to update your front-end (for example, WinCIM) when the spell check is 
completed.    Otherwise, Spell Check will ask you whether you want to update the frontend 
each time a spell check is completed.    Spell3.ini - AutoUpdate= Default is No

Clear Ignore All / Replace All Lists Before Each Spell Check.    If marked Spell Check 
will clear these lists before each Spell Check.    Otherwise, any words you "Ignored All" or 
"Replaced All" will be ignored or replaced, respectively, in all spell checks until Spell Check 
is closed.    Spell3.ini - ClearbeforeCheck= Default is No    

Close Custom Dictionaries after Each Check.    It is highly recommended that you do 
not change this setting.    Deactivating this feature will cause an error message if Word for 
Windows 6.X attempts to access the custom dictionary while Spell Check is active.    (Error 
also occurs under Word for Windows 2.X while using Windows for WorkGroups).    Spell3.ini
- CustomAllwaysOpen= Default is no (closed after each check).

Default Closing Settings.    Spell Check can automatically add a predefined closing, such 
as your name and email address to a message after it is checked.    See Closings    
Spell3.ini - SignMessage= Default is none

Help.    Invokes this help screen.

Spell Engine.    Invokes the Spell Engine Options dialog box.

Related Topics:
Setting Defaults
Modifying INI Files
Summary of Spell Engine Options    



Summary of Spell Engine Options
This section provides brief descriptions of the Spell Engine Options.    See Setting Defaults.   
If additional explanation is warranted the summary for the option will contain a jump to a 
topic that provides further clarification.    The Spell Check Engine Options are stored in the 
Spell3.INI File.    The line where the option is stored is denoted in Blue.    Default Settings 
denoted in Red.

Automatic Suggestions.    Spell check automatically generates suggestions for each 
misspelled word.    When automatic suggestions is deactivated the user must press the 
suggestions button in order to generate suggested spellings for each misspelled word.    
Spell3.ini - SpellOptionsBitSetting= Default is True

Exact Match Required.    When this option is selected Spell Check treats a word as 
misspelled if an exact match is not found in either the main dictionary or custom dictionary 
files.    For example, the word "This" would be treated as misspelled because the dictionary 
contains the word "this."    Spell3.ini - SpellOptionsBitSetting= Default is False 

Ignore Full Caps.    Spell Check ignores (does not check) words with all letters capitalized. 
For example, "SPELL CHECK".    Spell3.ini - SpellOptionsBitSetting= Default is False

Ignore Partial Numbers.    Spell Check ignores partial numbers.    For example, 12wrong.   
Spell3.ini - SpellOptionsBitSetting= Default is False

Ignore Pure Numbers.    Spell Check ignores pure numbers.    For example, 11.95.    
Spell3.ini - SpellOptionsBitSetting= Default is True

Allow Joined Words.    When this option is selected Spell Check treats hyphenated words 
as correctly spelled if both the individual words are spelled correctly.    Spell3.ini - 
SpellOptionsBitSetting= Default is True

Recheck Typed Replaces.    Spell check always checks replaces unless the user selects 
the "replace with word" from the suggestion list generated by spell check.    Spell3.ini - 
SpellOptionsBitSetting= Default is Not Used

Open Custom.    Spell Check allows you to have up to 5 custom dictionaries open 
simultaneously.    Add words you commonly use to custom dictionaries in order to avoid 
having spell check flag them as misspelled.    Spell3.ini - [Custom Dictionaries] Default 
is mwords.vtc    See Custom Dictionaries for further explanation.    

Open Standard.    Used to open standard (main) dictionary files.    Spell3.ini - [Main 
Dictionaries] Default is american.vtd

Performance. This setting controls the overall performance of the Spell Check engine. The
default setting balances memory usage with performance.    Increasing the performance 
level will allocate more memory to spell check and the speed of checking will increase.    
Likewise, decreasing the performance level will decrease the amount of memory allocated 
to Spell Check and decrease the speed of checking.    Spell3.ini - [Performance Level=]   
Default is 0 Range -7 to 7.

Suggestion Search Limit.    This setting controls the number of queries the spell check 
engine makes to the dictionary files when attempting to find the correct spelling of a word.  
Spell Check only displays the 10 best suggestions in the Suggestions list box. Spell3.ini - 
SuggestionsLimit= Default is 1500



Note:    Many of the options described above modify the Spell3.ini line 
SpellOptionsBitSetting=.    Spell Check converts the options selected to an integer value.    
The sum of the integer value is stored in the Spell3.ini file.    Therefore, it is not possible to 
set SpellOptionsBitSetting acurately by manually modifying spell3.ini.

Related Topics:
Custom Dictionaries
Define Options
Modifying INI Files
Summary of Default Settings



Modifying Spell Check's INI Files
Under most circumstances it will not be necessary to modify Spell Check's initiation files.    
Some users may wish to learn how to modify the stroke31.ini file, thus making it possible to
use Spell Check with any Windows application!        

Spell Check saves its various parameters in two initiation files (Spell3.ini and stroke31.ini).   

The Spell3.ini file stores information related to Default Settings, Spell Engine Options, 
Dictionaries and Closing. 

The stroke31.ini file stores the information necessary for Spell Check to exchange data with
other Windows Applications.    Spell Check never changes the Strokes.ini file, thus it must 
be modified by the user with a text editor. 

Related Topics:
Modifying Spell3.INI
Modifying stroke31.INI



Installation and Setup
Installing Spell Check is a relatively straight-forward process.    If you are familiar with how 
to unzip and copy a file it will take you no time at all.    If you are unfamiliar with the 
aforementioned process the detailed instructions below will walk you through the entire 
process.    By taking the time to install Spell Check you will not only gain access to a useful 
utility (Spell Check), but will develop the skills necessary to install any of the multitude of 
programs available from your on-line service.        

To have gotten this far you must have successfully downloaded the program and unzipped 
the file.    However, we will review this process below:

Downloading and unzipping:
1    When you download a file from an online service it is copied from the service's computer
to your computer via a modem.    Normally, the file will be downloaded to a sub-directory of 
the directory where your online service program resides.    For example, c:\waol\download 
for America Online or c:\cserve\download for CompuServe.

Note:    Step 2 describes the unzipping process.    If you downloaded Spell Check from    
America Online, the unzipping process may have been done automatically. 

2    To conserve disk space the online services store files in compressed format.    The most 
common format is pkzip.    There are numerous versions of pkunzip available and a variety 
of Windows programs to facilitate the unzipping process.    To unzip a file you simply type 
pkunzip filename destination at a DOS prompt.    To unzip Spell Check and store it in a 
directory type the following (bold lines) at a DOS prompt:

{create a directory for spell check}
md c:\spell
{unzip the file to the directory}
pkunzip wcspell.zip c:\spell

3.    Spell Check requires that vbrun300.dll be installed on your system.    For more 
information on how to download and installed vbrun300.dll see Installing Vbrun300.dll

4    Return to Windows and Run the Spell Check 3.1 Setup Utility    

5    Activate the Hot-Key Feature. 

6    You are ready to go - See Spell Checking a Message.

7    Evaluate the Program and decide whether to Register.

Related Topics:
Table of Contents
Understanding Spell Check and Menus
Using the Spell Check 3.1 Setup Utility



Registering Spell Check
Again, thank you for taking the time to download and evaluate Spell Check.    Spell Check is 
provided for evaluation purposes. If you decide to use the software, please register it.    We 
offer two registration alternatives.

1.    Registration without disk.    When registering in this manner you will be granted a 
legal license to use the software and we will send you the registered version of the program
(without the shareware screen) via electronic mail. The registration fee is only $11.95.

2.    Registration with disk.    When registering in this manner you will be granted a legal 
license to use the software and we will send you the registered version of the program 
(without the shareware screen) on diskette via conventional mail.    The registration fee is 
only $14.50, including shipping and handling.

The MailBag Plus and Spell Check Bundle is now shipping.    Get both utilities for 
only $23.00 (that's a $6.00 savings).    Just select the bundle option!

To register Spell Check using your Visa/Mastercard/Amex:
1    Press the Registration Info button in the Select Application Window or answer yes when 
exiting the program.
2    Fill-in the electronic order form. 
3    Choose a method to deliver your order to us.    We offer the following choices:

Print the Completed Order Form and Fax it to 703-560-1266

We accept orders 24 hours per day.    Our automated order processing system will 
take your order and we will send you the registered version as soon as possible.    
We send order confirmations via electronic mail so please include your full email 
address.

Print the Completed Order Form and Mail to:

Next Generation Software, Inc.
2831 Gallows Road Suite 201
Falls Church, VA 22042 USA

Send the Completed Order Form Via CompuServe or America Online:

Note:    If you send you order by email be sure that America Online or WinCIM is 
running before you select an order delivery method.    Spell Check will create an 
email message containing your order.    After the message is created please log on
and send the message.    Also, please do not modify the formatting of the order 
message.    You credit card information will NOT be transmitted on the Internet.    
Your order will be delivered by CompuServe or America Online Mail.

To register Spell Check by Check or Money Order:
1    Press the Registration Info button in the Select Application Window or answer yes when 
exiting the program.
2    Press the Check / MO button
3    Answer yes when prompted to print an order form

Mail the completed order form and your check or money order to:

Next Generation Software, Inc.



2831 Gallows Road Suite 201
Falls Church, VA 22042 USA

If you are a CompuServe subscriber you can register Spell Check using SWREG:
1.    Go SWREG
2.    Follow the onscreen prompts and search by ID#.
3.    To order Spell Check via email select program number 1761.    To order Spell Check on 
disk select number 2887.

Note:    Shipping and handling is included in the above prices for orders shipped to 
addresses within the United States.    Please add an additional $0.35 (without disk) or $0.50
(with disk) for orders shipped to Canada or Mexico.    All others please add an additional 
$1.00 (without disk) or $1.35 (with disk).

Related Topics:
Copyright Notice
Table of Contents

Click here to learn more about Next Generation Software's 
Shareware Utility MailBag Plus 1.1



Using WinCIS or WinNAV
Recently, both WinCIS and WinNAV were renamed by their publishers to GoCIS and CsNAV, 
respectively.

You must modify the strokes.ini file to make Spell Check aware that you are using    older 
versions of these programs.    Alternately, you can download new versions of GoCIS or 
CsNAV.    As of January 1994, users of WinNAV were entitled to a free upgrade to CsNAV.

If, however, you prefer to use the older version of the programs make the following 
changes to strokes.ini. 

See Modifying INI Files BEFORE making the following changes.

GoCIS to WinCIS

1.    Open c:\spell\stroke31.ini using a text editor (Windows Notepad)
2.    Move to the [Application 4] Section.
3.    Change all references to gocis to wincis.
4.    Change the number of letters lines to 6

CsNAV to WinNAV

1.    Open c:\spell\stroke31.ini using a text editor (Windows Notepad).
2.    Move to the [Application 3] Section.
3.    Change all references to csnav to winnav.
4.    Change all the number of letters line to 6. 

Related Topics
Modifying INI Files
Modifying Spell3.ini



A Quick Introduction to Spell Check 3.1.
Spell Check 3.1 is a high performance spell checker for the Windows Environment.    The 
program was originally designed to spell check mail messages created using the 
CompuServe Information Manager for Windows (WinCIM).    In each of the subsequent 
revisions to the program we have refined the spell checking engine as well as added 
support for additional Windows Applications.

One of our primary design priorities for Spell Check 3.1 was to ensure that all users, 
regardless of their technical knowledge, be able to successfully install and evaluate the 
program.    Furthermore, we wanted to make it easy for our users to take advantage of Spell
Check's numerous features.    In an effort to achieve this goal, we added a context-sensitive
help system to this version.    To invoke context-sensitive help while using Spell Check just 
press the F1 key.    

Please read the installation instructions contained within Spell3.wri before using the 
program.    See Opening Spell3.wri for the information on how to open spell3.wri.    

Be sure to see Using the Spell Check 3.1 Setup Utility.    The Setup Utility will create icons 
that let you take advantge of QuickStart Mode.

Supported Programs

Spell Check provides spell checking for: 

America Online
CsNAV
WinCIM
PC Eudora
You've Got Mail
WinFax
Windows Notepad
Windows Clipboard
Windows Write
Sierra Solutions MailRoom
NetCom's NetCruiser

Additionally, by Modifying Spell Check's INI Files users can customize Spell Check to work 
with almost any Windows Based application.      

The most exciting new feature in Spell Check 3.1 is related to the new version's ability to 
launch WinCIM, CsNAV and AOL (a single program manager icon starts both Spell Check 
and the frontend application).    Additionally, a "Spell Check" menu is added to the control 
box menu of the frontend (the control box can be accessed with a single click in the top 
lefthand corner of the program's main window).    Thus, Spell Check is only a menu click 
away.    Here is what the control menu look likes when Spell Check is active.    Note the Spell
Check menu item!:



Spell Check Engine

Spell Check 3.1 uses a robust spell checking engine.    The dictionary contains over 120,000 
words and users can Add Words not found in the main dictionary to Custom Dictionaries.    
The Spell Checker's functionality is consistent with the spell checkers found in full featured 
word processors.    Also, Spell Check provides you with a rich selection of User Defined 
Options allowing you to customize Spell Check.

Remember, Spell Check is shareware.    Next Generation Software, Inc. is distributing Spell 
Check 3.1 for evaluation purposes only.    After 30 days we ask that you either Register the 
Application or remove it from your system.      Register users will receive complete written 
documentation, legal license to use the software, and the registered version of the program 
(without the shareware screen).    The registration fee is only $11.95.    

To learn how to Spell Check a Message click here.

We accept voice/fax orders 24 hours per day.    Just fax or call 703-560-1266.    Our
automated call processing system will take care of your order and we will 
process it as soon as possible.    We send order confirmations via electronic mail 
so please include your full email address.

Checkout our Internet Homepage.    You will find the latest versions of our 
shareware programs, information on using Spell Check with popular Internet 
software and answers to frequently asked questions.    
Point your browser to http://www.xmisssion.com/~gastown/NEXTGENSFT/

Related Topics:
Spell Checking a Message
Registering Spell Check
Techincal Support
Using the Spell Check 3.1 Setup Utility
Other Features
Table of Contents

Click here to learn more about Next Generation Software's 
Shareware Utility MailBag Plus 1.1



Custom Dictionaries
Custom Dictionaries are used to store words that are correctly spelled, but are not 
contained within Spell Check's Main Dictionary.    During the installation process Spell Check
asks you whether you want to attach to the Word for Windows Custom Dictionary.    Sharing 
the custom dictionary makes words added while using one program available the next time 
you use the other program.    Word for Windows stores its custom dictionary file in \
windows\msapps\proof\custom.dic.    

Spell Check automatically attaches to the custom dictionary mwords.vtc during the 
installation process.

To Open a Custom Dictionary:
1    Press the Options Button in the misspelled word dialog box
        or 
        Press the Spell Engine Button in the Default Settings dialog box.
2    Press the Open Custom Button
3    Select a custom dictionary file or enter a new filename to create a new custom 
dictionary.

To Close a Custom Dictionary:
1    Press the Options Button in the misspelled word dialog box
        or 
        Press the Spell Engine Button in the Default Settings dialog box.
2    Select the dictionary you want to close from the drop down list.
3    Press the Close Custom Button.

Related Topics:
A Quick Introduction to Spell Check
Editing Custom Dictionaries
User Defined Options
Summary of Spell Engine Options      



Setting Defaults
Spell Check provides you with numberous options.    Spell Check's options can be classified 
in two broad categories.    The first category of options relate primarily to the program's 
operating configuration (Default Settings).    The second category relates primarily to the 
spell checking engine (Spell Engine Options).

To Define the Default Options:
1    Press the Defaults Button in the Select Application dialog box.
        or 
        Select the Defaults Item from the Edit Menu.

To Define the Spell Engine Options:
1    Press the Options Button when the misspelled dialog box is visible 
        or 
        Press the Spell Engine Button when you are Setting the Default Options as described 
above.

To Activate an Option Simply Select it by clicking your mouse.    An X means the option is 
selected.    An unmarked box denotes an unselected option.

Note:    Summaries of the various user defined options are provided to help you better 
understand the various settings.    See Related Topics below.    If additional explanation is 
warranted the summary for the option will contain a jump to a topic that provides further 
clarification.

Related Topics
A Quick Introduction to Spell Check
Summary of Default Settings
Summary of Spell Engine Options 

    



Defining a Closing
Spell Check allows you to define 2 closings.    After defining a closing Spell Check can add it 
to the end of your messages.    The closing can include up to five lines of text as well as the 
current time and date.    A typical closing might include your name and email address.    For 
Example:

Very truly yours, 
Barney Smith 
AOL - BSMITH@AOL.COM

To Define a Closing:
1    Press the Define Closing button in the Select Application window.
2    Enter the desired closing
3    Mark the date and/or time boxes as desired.
4    Press the OK button.
5    If you are satisfied with the Closing Press Yes.

To Select a Closing:
1    Select the No Closing, Closing 1 or Closing 2 in the Select Application window.

Note:    When adding a closing to your message Spell Check will determine whether you 
included a blank line at the end of your message (by pressing the enter key).    If you did 
not include a blank line Spell Check will add a blank line before attaching your closing.

Related Topics:
Setting User Default Options
      



Modifying Spell3.ini
The majority of the settings contained within the Spell3.ini file can be modified via the Spell
Check Default Settings screen or the Spell Check Engine Settings screen.    See those 
sections for description of the related Spell3.ini lines and default settings.

The Spell3.ini file is stored in the windows directory and can be modified using any 
standard text editor, such as the Window Notepad.

The following settings are not described in the aforementioned sections.

FrontEnd=    This setting corresponds to the default frontend and is of little value in the 
current version.    Spell Check 3.1 anticipates the application that contains the text you 
want to check.    If Spell Check cannot determine the application it will revert to this setting. 
The integer value corresponds to the order of the applications listed in the dropdown list 
box in the Select Application Window.    Default = 2
 
RemoveOldVersion=    Setting this line to yes will cause spell check to search for and 
delete older versions of the program.    After the process is complete Spell Check resets this
setting to no.

InsertSpace=    In prior versions, Spell Check inserted spaces in misspelled words while 
generating suggestions.    Although this process can be helpful at times it also results in 
erroneus suggestions.    Most users will find the tradeoff between erroneous suggestions 
and useful suggestions resulting from the insert space alogorthim to be in favor of setting 
this option to No. 

Related Topics
Summary of Default Settings
Summary of Spell Engine Options
Modifying stroke31.Ini    



Modifying Stroke31.ini
The stroke31.ini file stores the information necessary for Spell Check to exchange data with
other Windows Applications.    Spell Check never changes the stroke31.ini file, thus it must 
be manually modified by the user with a text editor. 

Be sure to backup stroke31.ini before attempting to modify it.
When the user chooses the application with text to be checked, Spell Check activates the 
application and sends the necessary keystrokes to highlight the text, copy it to the 
Windows ClipBoard and run it through the checker.    When the spell check is completed the 
text is copied back to the clipboard and pasted back into the application.    Spell Check does
not use the mouse to execute the aforementioned process.    Spell Check sends keystrokes.  
Thus, before modifying Spell Check to work with another Windows Application you must 
determine the following:

1    What keystrokes are necessary to highlight a block of text in the application.    Normally, 
CTRL + HOME will move you to the top of a window.    Then pressing SHIFT + CTRL + END 
will highlight the text in a window.      

2    Now that the text is highlighted all you need to do is copy it.    Most Windows 
applications use CTRL + C to copy.    Alternately, you could press the ALT key to open the 
menus, press E for the Edit Menu and C for the Copy Item.    We have found that some 
programs do not respond as expected when sending CTRL + C to copy (if you experience 
this problem try the ALT E C method described above).

3    After executing the above steps spell check will run your text through the checker.    Now
you must send the strokes necessary to paste the corrected text back into the application.   
Normally, CTRL + HOME, SHIFT + CTRL + END and CTRL + V will do the trick (CTRL + V 
means paste).

4    Your only other concern is providing the logic to activate the application, thus allowing 
the keystrokes to be sent.    Normally, the Title of the program as it appears in the task list 
will tell you what the application is "called" within the Windows enviroment.

The following section describes Spell Check's "macro langague."    Valid keystorkes are 
denoted in Blue.

To send the letter "A" your macro line should be A    To send the letters "ABC" your macro 
line should be ABC    

The SHIFT key is denoted by +
The CONTROL key is denoted by ^
The ALT key is denoted by %

( ) are used when you want to hold down a key and send another key or keys.    For 
example, to press and hold CTRL and then press V you would use the ^(V)      

Special characters are denoted by a keyword enclosed in { }.    Some of the more common 
keywords are described below:

END - {END}
ESC - {ESC}
HOME - {HOME}
LEFT ARROW - {LEFT}



PAGE DOWN - {PAGE}
TAB - {TAB}

The following section describes the stroke31.ini's various lines.      You must restart Spell 
Check for any changes made to stroke31.ini to take effect.

The first line NumberofApps= tells spell check how many application sections are stored 
in stroke31.ini.    The maximum value is 15.    You may want to remove sections for 
applications you do use.    Reducing the number of applications may improve performance 
on some systems.

Below is a sample of a strokes section for America Online.    We have provided descriptions 
for each line in Red below the valid stroke31.ini line.    Do not add descriptions to the 
stroke31.ini file.    

If you want to add support for another application we recommend that you copy an 
exisiting section and paste it to the end of the file.    Make your changes to the copied 
section.    Be sure to increment the NumberofApps line to reflect the additional application.

[Application 1]
Simply a place holder denoting the application's number

MenuItem=America OnLine 
Label used for the application in the Select Application Drop-down list.

ButtonLabel=AOL    
Label used to denote application 1 in message boxes.                            
ActivateName1=america
NumberofLetters1=7
ActivateName2=america
NumberofLetters2=7
Activate Name should correspond to the applcations name in its title bar.    The 
Number of letters should be the length of the activate name in characters.    Two 
different lines are provided for applications that change their title bar (WinCIM).  
Notice that it is only necessary to include a portion of the applciation's name.    
You must only use lowercase letters!

MailForumSame=yes
This line determines whether there are two types of messges (requiring two 
different sets of keystrokes) in the application.

Addmenuitem=yes
This line determines whether you want a "Spell Check" menu added to the top 
level menu of the application.    Spell Check can add its menu to up to three 
applications.    Spell Check will attempt to add its menu to the first three "yes" 
parameters it reaches when it reads stroke31.ini (from top to bottom).    
Therefore, if you add an application or modify an existing application's settings 
and want to make Spell Check add a menu item you will have to switch another 
applciation's settings to no.    The maximum number of menus that can be added 
is THREE.

ControlBoxOnly=no
Only meaningful if addmenuitem=yes. Changing the control box setting to yes 
will make Spell Check add a menu item to the control box only instead of both 
the top level menu and the control box.



Note:    To override the addmenuitem and controlboxonly parmenters start spell check with 
the /n argument.    See Understanding the Spell Check Command Line.

GMailStarts        Get Mail Message Section or first type of message.      
%( ){ENTER}      ALT + SPACE, ENTER Restores the Application    
^({HOME})              CTRL + HOME    Move to begining of text
+(^({END}))          SHIFT + CTRL + END Highlights entire block
^(C)                                    CTRL + C    Copies entire block
%( )                                    ALT + SPACE Opens the control box.
n                                              n N to minimize America Online
GMailEnds            End of Getmail section.

PMailStarts        Paste mail section.    Executed after the spell check is completed.    
%( ){ENTER}      ALT + SPACE, ENTER Restores the Application    
^({HOME})              CTRL + HOME    Move to begining of text
+(^({END}))          SHIFT + CTRL + END Highlights entire block
^(V)                                    CTRL + V    Paste the checked text.                        
PMailEnds            End of the Paste Mail section. 

GForumStarts
GForumEnds 
PForumStarts
PForumEnds 
The above sections would be used if MailForumSame=no (WinCIM).

Finally a brief discussion is warrented regarding how to restore a Windows application and 
its impact on the sizing of the application's window.    The above example restores America 
Online.    You may prefer to maximize the application first ^( ) x then restore it %( )
{ENTER} before copying the text.    In doing so, the applications Window will be the same 
size after the Spell Check returns the corrected text.    However, you may find the resizing 
annoying or too slow on some machines.

Related Topics:
Modifying INI Files
Modifying Spell3.ini
Using Spell Check with WinCIS and WinNAV



Opening Spell3.wri
Spell3.wri contains complete installation directions.    Please read the file carefully in order 
to ensure that you install Spell Check correctly, thus enabling you to get the most out of its 
powerful feature set.

To Open spell3.wri:
1    Double Click on the File Manager Icon in the Program Manager
2    Change to the directory containing spell3.wri
3    Double Click on the spell3.wri

Note:    If you are not sure what directory contains the file spell3.wri, select the Search Item
from the File Menu in the File Manager.    Enter spell3.wri in the Search For Box and c:\ in the
Start From Box.    Press Enter.    Double Click on spell3.wri.

Related Topics:
Table of Contents
A Quick Introduction to Spell Check    



Using the Select Application Dialog Box
The Select Application Dialog Box is the heart of Spell Check and provides you with access 
to the functions necessary to successfully use the program.    Conceptually, you must create
the text, select the program containing the text to be checked, select a closing, select other
options and select the message type.    As you become more familiar with Spell Check, you 
will learn the configuration that best meets your needs and may find it desirable to set it as
your Default Configuration.        

To Begin Checking a Message:
1    If the Select Application Window is not visible press the Get Message Button, otherwise 
skip to Step 2.
2    To Select the Application that contains the text you want to check choose the 
application's name from the drop-down list.    Under most circumstances Spell Check will 
anticipate what application contains the text.
3    Select a Closing.    Spell Check can automatically add a closing, such as your email 
address, to the message after the spell check is completed.    See Defining a Closing for 
more information on closings.    
4    Select the desired Other Options.    Auto Update will cause Spell Check to automatically 
update the corrected text to the frontend application when the spell check is completed.    
Stay on Top will make the Spell Check icon remain visible after the spell check is 
completed.    See Summary of Default Settings.      
5.    Select the Type of Message (Mail or Forum) or press the Text button.
6.    Spell Check will grab the text and spell check it.    See Using the Misspelled Word Dialog 
Box.

Note:    To set the startup defaults press the Defaults button.

Related Topics:
Activating the Hot-Key Feature
Adding Spell Check to the Startup Group
Adding Spell Check's Icon to the Program Manager
Summary of Default Options
Using the Misspelled Word Dialog Box



Files
The following files must be installed in the same directory for Spell Check to function 
correctly:

wcspell3.exe
wcspell3.hlp
vtspell.vbx
american.vtd
stroke31.ini
readme.txt
order.frm
mwords.vtc
vbmsg.vbx

Also, Spell Check 3.1 requires that the file vbrun300.dll be installed in either the Spell 
Check directory or the windows\system directory.

Note:    Spell Check creates the file spell3.ini in your windows directory.    NO modifications 
are made to your computer's configuration files (win.ini, system.ini, autoexec.bat, etc.).

Related Topics:
Installing Spell Check
Installing Vbrun300.dll



Installing VBRUN300.DLL
Vbrun300.dll is a dynamic link library file used by Spell Check.    Numerous other programs 
use the file so you may already have it on your system.    If Spell Check runs on your 
computer, vbrun300.dll must be installed.    

Unfortunately, most online services do not allow software publishers to include a copy of 
vbrun300.dll with their programs.    As you might expect it would eat lots of precious disk 
space.    Likewise, users do not want to waste their time and money downloading a file they 
already have.

To determine whether vbrun300.dll is installed on your system:
1    Start the Windows File Manager.
2    Select the Search Item from the File Menu.
3    Enter vbrun300.dll in the Search For Box
4    Enter c:\ in the start from box
5    Press enter
6    If the file is found make sure that it is installed in the windows\system directory.    
Installing vbrun300.dll in the system directory will allow all programs that require this file to
have access to it.

If your search for vbrun300.dll is unsucessful then you must download the file.

To Download VBRUN300.DLL from CompuServe:
1    Go Wugnet by pressing the Green Light Icon and entering wugnet.
2    Press the Books Icon to open Libraries
3    Double Click on Batch and Basic Lib
4    Scroll down to the file "Updated Visual Basic Runtime" dated 10/24/93.
5    Press Retrieve
6    See Below for information on unzipping and installing vbrun300.dll

To Download VBRUN300.DLL from America Online:
1    Select the Keyword item from the Goto Menu.
2    Enter Quickfind and press enter.
4    Enter vbrun300.dll and press Enter.
5    Download the file.
6    Double click on the "download" directory in the filename dialog box.
7    AOL will download the file and unzip it to c:\waol\download\vbrun300.

To Download VBRUN300.DLL from Prodigy:
1    Select the Jump to Item from the Jump Menu.
2    Enter Ziffnet
4    Enter Visual Basic Runtime.
5    Select Vbrun300.dll
6    Download the File.
7    See below for information on unzipping and installing vbrun300.dll

Note:    After you download the file you must ensure that it is unzipped and moved to the 
windows\system directory.    If you downloaded vbrun300.dll from America Online the 
unzipping process will be completed for you.    However, you must be sure that vbrun300.dll
is stored in the windows\system directory.    America Online should unzip the vbrun300.dll 
to c:\waol\download\vbrun300\vbrun300.dll.    Thus, you will need to move the file from c:\
waol\download\vbrun300\vbrun300.dll to c:\windows\system.    

To unzip vbrun300.dll:



1    Exit to a Dos Prompt.
2    Change to the download directory.
3    Type pkunzip vbrun300.zip c:\windows\system Press Enter

To ensure that vbrun300.dll is installed in the windows\system directory:
1    Start the Windows File Manager
2    Select the Search item from the File Menu
3    Enter vbrun300.dll in the Search For Box
4    Enter c:\ in the Start from Box
5    Press Enter.
6    If vbrun300.dll is not stored in windows\system directory then select the file and Select 
the Move item from the File Menu.    Enter c:\windows\system and press enter.

Related Topics:
Installation and Setup
Using the Spell Check 3.1 Setup Utility



America Online
America Online provides users with a variety of online services including the Internet 
Center.    The Internet Center provides Gopher, WAIS, FTP, and Mailing Lists Support.      For 
information on a free month of America Online access phone 1-800-827-6364.

Click here to learn more about Next Generation Software's 
Shareware Utility MailBag Plus 1.1



CompuServe
CompuServe provides its users with a vast array of information, including application 
specific forums sponsored by all major software companies.    CompuServe publishes two 
windows based front-ends for the CompuServe Information Service.    WinCIM provides an 
easy to use interface for exploring the service and CsNAV provides a robust scripting 
language to write automated CompuServe sessions.    For more information on CompuServe
dial 1-800-848-8990.

 



MailRoom
MailRoom is a Windows based mail application for use with MCI Mail.    For more information
on MailRoom email Sierra Solutions (MCI Mail: 545-0183).



gocis

      



Windows Clipboard
Windows stores any information cut or copied from an application in the Clipboard until it is
pasted to another location or until another piece of information is cut or copied.    Spell 
Check can check any text stored in the clipboard for misspellings and update the clipboard 
when it has completed the check.    Thus, one could copy text in an application, switch to 
Spell Check, select the Clipboard application, press the text button, and spell check the 
text.    After the spell check is completed the text can be updated to the clipboard at the 
user's option.    Once the text is updated (copied) back to the clipboard by Spell Check you 
can paste the corrected text in the desired Windows application.    This feature makes it 
easy to check any block of text in the Windows Enviroment! 



Windows Notepad and Norton's DeskEdit
The Notepad and DeskEdit are included with Windows and Norton's DeskTop for Windows, 
respectively.    These simple applications provide basic text editing features.



Prodigy for Windows
The Prodigy Service recently released a Windows based front-end.    The next release of 
Spell Check will provide spell checking for Prodigy for Windows.    If you are interested in 
using Spell Check with Prodigy please drop us a line and we will help you get started right 
away.    For more information on Prodigy telephone 1-800-776-3449.
 



WinFax
WinFax is faxing software for the Windows Environment.    Spell Check can check the 
spelling of WinFax cover sheets.    For more information on the WinFax Software contact 
Delrina at 1-800-268-6082.      



Microsoft Mail
Spell Check supports the version of Microsoft Mail included with Windows for WorkGroups.    
This version of Mail is worth a look especially if you have Windows for WorkGroups installed 
on your machine.    



Using Spell Check with Norton Desktop
Spell Check 3.1 is compatible with Norton Desktop for Windows.    Furthermore, version 3.1 
includes support for Destop's text editor "DeskEdit".    Under Desktop, you can add Spell 
Check to the startup group as well as the Launch List.    

To add Spell Check to Norton Desktop's Startup Group:
1    Select the Quick Access item from Desktop's Window menu.
2    Double Click on the Startup Group.
3    Select the New Item from the Group Menu.
4    Click on the General Icon
5    Enter the Program's Title.    For example, "Spell Check"
6    Enter the Filename.    For example, "c:\spell\wcspell3.exe"
7    Click on Advanced
8    Enter the Startup Directory.    For example, "c:\spell"
9    Enter a Description.    For example, "Spell Check"
10 Move to the shortcut key field and press CTRL + ALT + S
11 Select Normal from the Run Style dropdown list.
12 Press OK

Note:    Under Desktop, you must have the Desktop Manager in the foreground the first 
time you press the hot-key combination.    In other words, Spell Check will not be activated 
if you press the hot-key combination for the first time while using another application, 
such as WinCIM.    The hot-key will call Spell Check while using another application (such as 
WinCIM) if Spell Check is already running.    

Note:    If you want to add Spell Check to your Launch List follow the directions in you 
Norton Desktop User Guide page 6-6.    To run Spell Check minimized you must activate the 
Run Minimized feature via Spell Check's Default Settings.

      



Maximizing an application after a spell check
Some users prefer using their applications "maximized".    On some systems Spell Check 
will resize an application's window to a non-maximized state after completing a spell check.
It is possible to Modify the stroke31.ini file to ensure that an application is returned to the 
maximized state after each Spell Check.

To configure Spell Check to Maximize an application after a spell check:
1    Open the file stroke31.ini using the Windows Notepad.    The stroke3.ini file is stored in 
the same directory as the other spell check files.
2    Scroll to desired section.    For example, "Application 2".
3    Move to the "PmailStarts" section.
4    Add the following line before "PMailEnds"
        %( )x
        Note that there is space between the ( ).    Thus, the line is %(space)x      
5    If MailForumSame=yes for the application you should repeat steps 3 and 4 for the 
PForumStarts section.

Note:    You will need to close Spell Check and restart it after making the aforementioned 
changes. 

Related Topics:
Modifying stroke31.ini



Conflict with BarClock
Spell Check uses the Windows standard commands to copy text (CTRL + C).    While using 
BarClock pressing ctrl + c invokes BarClock's calender feature.    Thus, when the user 
presses ctrl + c or program such as Spell Check presses ctrl + c and BarClock is running 
BarClock's calendar will be invoked.

Atomic Dog Software the publishers of BarClock offer the following fix:

>>You can disable the BarClock hot keys by editing the .INI file and changing the three 
lines that begin with 'HK' so they equal 0.

For example,

HKCalendar=0 HKTimer=0 HKAlarm=0

This will be addressed in an upcoming release of BarClock.<<

The ini file discussed above is the ini file for BarClock.



Windows Write
Spell Check supports the word processing utility Write that is included with Microsoft 
Windows.



PC Eudora
PC Eudora is a popular email front-end for Internet Mail.    The program can be downloaded 
from most major internet sites.    Spell Check has been tested with versions 1.4.3 and 1.4.4. 
Note that you must place you cursor in the message window before invoking Spell Check.    
In other words, Spell Check will not work correctly if you cursor is located in the To: field (it 
will check the to: field), it should be in the message field (at the bottom of the window). 



You've Got Mail
You've Got Mail is a popular email frontend for America Online.    Like Spell Check YGM is a 
shareware utility that can be downloaded from America Online.

Click here to learn more about Next Generation Software's 
Shareware Utility MailBag Plus 1.1



Using the Spell Check 3.1 Setup Utility
The Spell Check 3.1 Setup Utility was designed to make it easy to setup Spell Check and 
take advantage of some of the program's advanced features, such as using the "QuickStart 
Mode".

Specifically, the Setup Utility will create a set of icons that you can use to launch Spell 
Check in a variety of ways.    

To create the Standard Spell Check Icons:
1    Double Click on the SPSETUP.EXE file in the File Manager.
2    Press the Create Standard Icons for Spell Check button.

To create an Icon that will launch a frontend and Spell Check.
1    Double Click on the SPSETUP.EXE file in the File Manager or
        Double Click on the Spell Check 3.1 Setup Utility icon in the Spell Check program group.
2    Switch to the Program Manger
3    Start the desired frontend application.
4    Switch back to the Setup Utility by double clicking on the Setup Utilitiy Icon.
5    Press the button corresponding to the frontend application you want to create the icon 
for.

The utility will create an icon that lauches the frontend (WinCIM, etc) and then Spell Check. 
Advanced users may want to read Understanding the Spell Check Command Line.    

Note:    The SPSETUP Utility as well as Spell Check 3.1 requires that Vbrun300.dll is 
installed on your system.

Related Topics:
A Quick Introduction to Spell Check 3.1
Installing Spell Check 3.1



Starting the Setup Utility
The Spell Check 3.1 Setup Utility makes it easy to install Spell Check.    To activate the 
utility just double click on the file spsetup.exe or follow the step by step instructions 
detailed below.

To start the SPSETUP Utility:
1    Double Click on the File Manager Icon in the Program Manager (Mail Program Group).
2    Select the Search item from the file menu.
3    Enter spsetup.exe in the search for box
4    Enter c:\ in start from box. 
5    Press Enter.
6    Double click on the results of your search.    

The file manager should have found the file "c:\spell\spsetup.exe"    (America Online users 
probably found the file "c:\aol20\download\wcspell3\spsetup.exe").

Just like the main Spell Check program SPSETUP requires vbrun300.dll

Related Topics:
Using the Spell Check 3.1 Setup Utility
Installing Spell Check 
Using the Hot-key Feature



Understanding the Spell Check Command Line
The Spell Check 3.1 command line can except arguments.    

Spell Check's command line uses the following format:

wcspell3.exe [application to launch] [switch]

Where [application to launch] is the full path name of an executable program.    For 
example, a typical command line for Spell Check and WinCIM would read "c:\spell\
wcspell3.exe c:\cserve\wincim\wincim.exe".    In this case the correct working directory 
would be "c:\spell".

Spell Check supports a single command line switch that should only be used when the user 
wants to disable Spell Check's ability to add menu items to WinCIM, AOL, or CsNAV.    
Assuming Spell Check is stored in c:\spell and you don't want Spell Check to add menus to 
frontend applications you could use this command line, "c;\spell\wcspell3.exe /n"

To change the arguments for a Spell Check icon:
1    Close Spell Check.
2    Select the desired Spell Check icon in the Program Manager with a single click.
3    Select the Properties Item from the File Menu in the File Manager.
4    Modify the Command line as described above.

Related Topics:
Understanding Spell Check and Menus



QuickMode
QuickMode makes it easy to launch Spell Check and another application.    For example, 
many users need to launch Spell Check every time they use WinCIM.    The Setup Utility 
creates an icon "Spell Check & WinCIM".    When you double click on this icon Spell Check 
and WinCIM are launched.    Thus, both programs are ready to make you more productive.



Understanding Spell Check and Menus
Spell Check 3.1 can add menus to up to three applications.    

To invoke Spell Check simply click on the menu.    Spell Check can add two different type of 
menus.

The control box menu is the menu at the top left hand corner of all Windows (it looks like a 
minus sign).

To access the control box menu:
1    Select the menu with your pointer or
        Press and hold the ALT key and then press the Space Bar.
2    Click on the Spell Check icon

The top level menu is the menu that includes the file menu and normally ends with the help
menu.    Spell Check will add a menu after the help menu.

To access Spell Check from the top level menu:
1    Select the Spell Check menu

Note:    Spell Check must be running in order for the Spell Check menu item to be visible.    
See QuickStart mode to learn how to create an icon that lauches Spell Check and your 
frontend applcation automatically.

Under its default settings Spell Check adds menus to the following applications:

WinCIM    Both the control box and WinCIM's top level menu.    When using some forums 
the top level menu will not be visible.    To invoke the Spell Check in this situation simply 
click on the Spell Check item under WinCIM's control box menu.

CsNAV    Spell Check adds a menu to the control box only because of the advanced nature 
of CsNAV's windowing scheme.

America Online Both the control box and WinCIM's top level menu.    

Related Topics:
Using the Spell Check Setup Utility
Modifying Stroke31.ini
Understanding Spell Check's Command Line



MailBag Plus 1.1 for AOL
MailBag Plus 1.1 is a highly integrated filing cabinet tool for America Online that will enable 
you to organize your AOL mail or any other text during your online sessions.

FlashSessions are one of America Online 2.0's most exciting new features.    Flash Sessions 
make it much easier to send and receive email.    However, as we began to use AOL for a 
signifiant amount of correspondence we noticed that our Incoming Mail window filled up 
and that AOL apparently left out some important features.    For example, AOL 2.0 does not 
include tools to easily store and archive important correspondence.    MailBag fills the 
void by providing this important feature in the form of easy to use AOL Add-on. 

I understand how MailBag will help me better manage my email, but what is the "Plus" in 
MailBag Plus?    Well, we didn't stop with Mail.    MailBag Plus allows you to "grab" 
almost any information found on AOL and store it on your computer.    Thus, 
instead of spending time reading articles or other information online you can save them in 
MailBag and read them at your leisure without incurring connect time charges.

When you double click on the MailBag Plus icon, MailBag will start AOL and a new menu 
item will be added to America Online's Mail menu.    Simply click on the MailBag Plus menu 
item to access the program.    

In order to make it easy to access MailBag's multitude of features the program uses a 
Tabbed Control.    To access a Tab simply click on it with your mouse.    Below is picture of 
MailBag's Tabs.    

It easy to obtain an evaluation version of MailBag Plus 1.1

1    Logon to AOL
2    Select Keyword from the Goto Menu
3    Enter quickfind and press enter
4    Enter mailbag1.zip and press enter
5    Download the file
6    End your AOL session
5    Double click on mbsetup.exe

We offer a significant discount if you decide to register both Spell Check and MailBag. 

Related Topics:
Registering 



Using Spell Check with GoCIS
1.    Open the file stroke31.ini using the Notepad
2.    Increment the numberofapps line as follows
        NumberofApps=current value + 1.
        In most cases, the new value will be 13.

[Application 13]
MenuItem=GoCIS
ButtonLabel=GoCIS
ActivateName1=gocis
NumberofLetters1=5
ActivateName2=*gocis
NumberofLetters2=6
MailForumSame=yes
Addmenuitem=no
ControlBoxOnly=no
GMailStarts
%( ){ENTER}
^({HOME})
+(^({END}))
^(C)
%( )
n
GMailEnds 
PMailStarts 
%( )x
^({HOME})
+(^({END}))
^(V)
PMailEnds 
GForumStarts 
GForumEnds 
PForumStarts 
PForumEnds 



NetCom's NetCruiser
NetCruiser is an integrated front-end for the Internet.    For information on NetCruiser dial 1-
800-353-6600.

Click here for more information on using Spell Check with NetCruiser.



Using Spell Check with NetCruiser
We are working to improve compatibility with NetCruiser.    Visit our homepage for the latest
information on using Spell Check with NetCruiser as well as other Internet software.    Point 
your World Wide Web browser to http://www.xmission.com/~gastown/NEXTGENSFT/

This version of Spell Check should work in without a hitch in the following modes.

Electronic Mail
Posting a reply to a USENET Message

If you want to post a new message to USENET Group (not post a reply to an existing 
message).

Create the message
Spell Check the message
Enter the Name of the newsgroup
Enter a subject
Post the Message




